This compact, tabletop Atomic
Force Microscope has all the
important features and benefits
expected from a light lever AFM.
The TT-AFM includes everything
you need for AFM scanning:

a stage, control electronics,
probes, manuals, and a

video microscope.

TT-AFM

For:
» Nanotechnology Researchers

Wanting to do routine scanning of nano-structures.

» Instrument Innovators
Using AFM as a platform to create a new instrument.

> Educators

Teaching students about AFM construction, operation,
and applications.

AFEM

upto 1" X 1" X 1/4"

Vibrating, Non Vibrating, Phase, LFM

50 X 50 X 17 microns, 15 X 15 X 7 microns
Zoom to 400X, 1.5 micron resolution

Compact Tabletop Design



STAGE

The TT-AFM stage has excellent
thermal and mechanical stability
required for high resolution AFM

scanning. Additionally, its open design

facilitates user modification.

V1.5

Rigid Frame Design
The crossed beam design for the stage support is extremely rigid so
the AFM is less susceptible to external vibrations.

Light Lever AFM Force Sensor
Light lever force sensors are used in almost all atomic force
microscopes and permit many types of experiments.

Integrated Probe Holder/Probe Exchanger
A unique probe holder and clipping mechanism allows quick and
easy probe exchange.

Direct Drive Z stage

A linear motion stage is used to move the probe in a perpendicular
motion to the sample. Probe/sample angle alignment is not required,
facilitating a much faster probe approach.

Small Footprint
The stage dimensions of 7.5 X 12" require little space and fit easily on
a tabletop.

Precision XY Stage with Micrometer

The sample is moved relative to the probe with a precision xy
micrometer stage. Thus, the sample can be moved without
touching it.

Modes Electric Plug
A six pole electrical plug is located at the back of the stage to
expand the capabilities of the TT-AFM.

XYZ Precision Piezo Scanner

The modified tripod design utilizes temperature compensated strain
gauges which assure accurate measurements from images. Also,
with this design it is possible to rapidly zoom into a feature visualized
in an image.

Laser/Detector Alignment

Both the light lever laser and the photo detector adjustment
mechanism may be directly viewed. This feature simplifies the
laser/detector alignment.

Adaptable Sample Holder

At the top of the XYZ scanner is a removable cap that holds the
sample. The cap can be modified - or a new cap can be designed - to
hold many types of samples.

High resolution video microscope
Direct drive Z motor stage

Light lever force sensor

Mode input/output plug

XYZ linearized piezo scanner

XY sample translation stage
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EBOX

Electronics in the TT-AFM are
constructed around industry standard
USB data acquisition electronics. The
critical functions, such as xy scanning,
are optimized with a 24 bit digital to
analog converter. With the analog z
feedback loop, the highest fidelity
scanning is possible. Vibrating mode
scanning is possible with both phase
and amplitude feedback using the high

sensitivity phase detection electronics.

V1.5

24 bit scan DAC

Scanning waveforms for generating precision motion in the X-Y axis
with the piezo scanners are created with 24 bit DACS driven by a

32 bit micro controller. With 24 bit scanning, the highest resolution
AFM images may be measured. Feedback control using the xy strain
gauges assures accurate tracking of the probe over the surface.

Phase and Amplitude Detector Circuit

Phase and amplitude in the Ebox are measured with highly stable
phase and amplitude chips. The system can be configured to feed
back on either phase or amplitude when scanning in vibrating mode.

Signal Accessible
At the rear of the eBox is a 50 pin ribbon cable that gives access to all
of the primary electronic signals without having to open the eBox.

Status Lights

At the front of the Ebox is a light panel that has 7 lights. In
the unlikely event of a circuit failure, these lights are used for
determining the status of the Ebox power supplies.

Precision Analog Feedback

Feedback from the light lever force sensor to the Z piezoceramic is
made using a precision analog feedback circuit. The position of the
probe may be fixed in the vertical direction with a sample-and-hold
circuit.

Variable Gain High Voltage Piezo Drivers
An improved signal to noise ratio, as well as extremely small scan
ranges are possible with the variable gain high voltage piezo drivers.

Microprocessor for scan generation through 24 bit DAC's

Low noise, variable gain high voltage amplifiers with PID feedback for XY
scanning

Dimensions: Width 6" | Height 10" | Depth 14"

High fidelity, low noise z feedback circuits for accurate probe tracking
Phase and amplitude detection circuits for vibrating mode AFM
Industry standard National Instruments USB data acquisition board
Internally accessible header for signal input/output

Eight channels of ADC for monitoring and displaying data with LabView
software
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SOFTWARE

Software for acquiring images

is designed with the industry

standard LabVIEW™ programming
visual interface instrument design
environment. There are many
standard functions, including setting
scanning parameters, probe approach,
frequency tuning, and displaying
images in real time. LabVIEW™
facilitates rapid development for those
users seeking to enhance the software
with additional special features.
LabVIEW also enables the TT-AFM to
be readily combined with any other

instrument using LabVIEW VI.

V1.5

» Pre-scan Window
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A pre-scan window
includes all of the
functions that are
required before a scan

is started. The functions
are presented in a logical
sequence on the screen.

Once all of the steps in
the pre-scan window
are completed, the scan
window is used for
measuring images. Scan
parameter, Z feedback
parameters, and image
view functions may be
changed with dialogs on
this screen.

Industry standard
programming
environment.

Readily customized

and modified for
specialized applications.
Instrumentation already
using LabVIEW can be
added to the TT-AFM to
create new capabilities.
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IMAGE
ANALY SIS
SOFTWARE

Included with the TT-AFM is the
Gwyddion open source SPM image
analysis software. This complete
image analysis package has all
the software functions necessary
to process, analyze and display

SPM images.

File

Edit

Data Process
Graph

Meta

= View

L2PLLT

[=] Data Process

Frorererisl

2 WD

¥

Y

V1.5

visualization: false color representation with different types of
mapping

shaded, logarithmic, gradient- and edge-detected, local contrast
representation, Canny lines

OpenGL 3D data display: false color or material representation
easily editable color maps and OpenGL materials

basic operations: rotation, flipping, inversion, data arithmetic, crop,
resampling

leveling: plane leveling, profiles leveling, three-point leveling, facet
leveling, polynomial background removal, leveling along user-defined
lines

value reading, distance and angle measurement

profiles: profile extraction, measuring distances in profile graph,
profile export

filtering: mean, median, conservative denoise, Kuwahara, minimum,
maximum, checker pattern removal

general convolution filter with user-defined kernel

statistical functions: Ra, RMS, projected and surface area, inclination,
histograms, 1D and 2D correlation functions, PSDF, 1D and 2D
angular distributions, Minkowski functionals, facet orientation
analysis

statistical quantities calculated from area under arbitrary mask
row/column statistical quantities plots

ISO roughness parameter evaluation

grains: threshold marking and un-marking, watershed marking

grain statistics: overall and distributions of size, height, area, volume,
boundary length, bounding dimensions

integral transforms: 2D FFT, 2D continuous wavelet transform (CWT),
2D discrete wavelet transform (DWT), wavelet anisotropy detection

fractal dimension analysis

data correction: spot remove, outlier marking, scar marking, several
line correction methods (median, modus)

removal of data under arbitrary mask using Laplace or fractal
interpolation

automatic xy plane rotation correction
arbitrary polynomial deformation on xy plane
1D and 2D FFT filtering

fast scan axis drift correction

mask editing: adding, removing or intersecting with rectangles and
ellipses, inversion, extraction, expansion, shrinking

simple graph function fitting, critical dimension determination
force-distance curve fitting

axes scale calibration

merging and immersion of images

tip modeling, blind estimation, dilation and erosion

WEEESHIEE 1434 East 33rd St., Signal Hill, CA 90755 | P: (714) 402-8253

05



VIDEO
MICROSCOPE

A video optical microscope in an AFM
serves three functions: aligning the
laser onto the cantilever in the light
lever AFM, locating surface features
for scanning, and facilitating probe

approach. The TT-AFM includes
a high performance video optical
microscope along with a 3 mega pixel
ccd camera, light source, microscope
stand, and Windows software for

displaying images.

PROBE HOLDER/
EXCHANGE

The TT-AFM utilizes a unique probe
holder/exchange mechanism. Probes
are held in place with a spring device

that mates with a probe exchange
tool. With the probe exchange
tool, changing probes takes only a

few minutes.

V1.5

Video microscope used to locate
surface features for scanning.
The Vibrating Mode Cantilever is
125 p long.

Laser alignment is greatly
facilitated with the video optical
microscope. This non-vibrating
cantilever is 450 p long. The red
spot is from the laser reflecting
off the cantilever.

Probe Holder

Probe Exchange Tool

Probe Inserted in Clip
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TT-AFM
IMAGES

With a vertical noise floor of 0.1 nm
and a horizontal resolution of 2 nm,
most types of samples may be imaged

with the TT-AFM. These include hard

30 X 30 p Spores

as well as soft samples.

OPEN DESIGN

An open design is at the core of

all products offered by the AFM

Workshop. New types of experiments

are more readily designed and

implemented through the use of Lab

View software. All the mechanical

drawings for the TT-AFM are available
in the documentation package option.
Finally, the company’s website offers
a Users Forum to directly share
specialized designs developed for the

TT-AFM. For specialized applications,

other types of scanners such as
flexure and tubes can be easily added

to the microscope stage.

g v , W S

2 X 2 p - BOPP polymer fiber | | 25X 25 p - parasites | | 300 X 300 nm -Phase PMMA

V1.5
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SCANNING
M O D ES With the window below, the resonance frequency of a cantilever is

readily measured. Additionally, the phase characteristics of the probe

, sample interaction are captured.
Standard with every TT-AFM are non-

vibrating(NV) mode and vibrating(V) —
) Ampliude  Phase
modes for making topography scans. tpel (e Preaency Bulect
- ¥ ’
- . . sl ¥ Syara0ry D Lo (Hz)
Additional modes included with the E m| gy
4- 3 fi A0 A0 P00 2SSO0 2TE000 RS0 7000 XSO0 200
product are lateral force imaging J-,'l "’“'_:l E=m 3
oW 0l T sty FE
as well as phase mode imaging. All oo S0} i i
[T
of the scanning modes that can be T e e
Fragutnicy Hi)
implemented with a light lever AFM -

are possible with the TT-AFM.

TT-AFM
O PTl O N S » Environmental Cell

Permits scanning in inert environments or liquids.

Although the TT-AFM comes with » Scanner Fabrication Tool

everything you need to make Facilitates scanner fabrication.
AFM images, several options are » High Resolution Scanner
currently available. Allows a range of 15 X 15 microns in XY and 7 microns in Z.

» Vibration Cabinet
Reduces unwanted acoustic and structural vibrations.

» Conductive AFM
Measures the 2-D conductivity of sample surfaces.

AFM Workshop regularly develops new Options.
Contact AFM Workshop for more information on options for the TT-AFM.

i
|

Vibration Enclosure Environmental Cell 15 micron scanner

AFM "
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SPECIFICATIONS

>

WoRKSHOR

50 Micron xyz Scanner
» Type

» XY Linearity

» XY Range

» XY resolution

» XY Actuator type
» Sensor type

» Z Range

» Z Linearity

» Z sensor noise
» Z feedback noise
» Z Actuator Type
» Z Sensor type

15 Micron xyz Scanner
» Type

» XY Linearity

» XY Range

» XY resolution

» XY Actuator type
» Sensor type

» Z Range

» Z Linearity

» Z sensor noise

» Z feedback noise
» Z Actuator Type

» Z Sensor type

Sample Holder

» Type

» Max Lateral Dimensions
» Max. Height

Light Lever AFM Force Sensor

» Probe Types
» Probe insertion

» Probe holding mechanism

» Laser/Detector adjustment range

» Adjustment resolution
»  Minimum Probe to Objective
» Laser Type
» Detector
Type
Band Width
Signals Transmitted
Gain
» Probe sample angle

V1.5

Modified tripod
<1%

>50p

<10 nm closed loop
< 1 nm open loop
Piezo

Strain Gauge

> 16y

<5%

<bnm

<0.2nm*

Piezo

Strain Gauge

Modified tripod
<1%

>15p

<3 nm closed loop
< 0.3 nm open loop
Piezo

Strain Gauge

>7u

<b5%

<5 nm

<0.1 nm*

Piezo

None

Magnet
1 inch
0.25 inch

Industry standard
Manual - probe
exchange tool

Clip

Vibrating mode piezo
Electrical connector to
probe

+/- 1.5 mm

1 micron

25 mm

670 nm diode, < 5 mw

4 quadrant

> 500 kHz
TL,BL, TR, BR
Lo, High Settings
10 degrees

p XY Translator

» Range

» Resolution
» Type

» Lock Down

Z Motion

» Type

» Range

» Drive Type

»  Min. Step Size
» Slew Rate

» Limit Switch
» Control

Digital Data Input Output

» Connection

» Scanning DAC
Number
Bits
Frequency

» Control DAC
Number
Bits
Frequency

» ADC
Number
Bits
Frequency

Analog Electronics

» Vibrating Mode
Freq Range
Output Voltage
Demod. Freq

» Z Feedback
Type
Bandwidth
Sample Hold
Voltage

» XY Scan
Voltage
bandwidth
Pan & Zoom

» Tip Approach Cutoff

25.4 mm

2y

Bearing - spring loaded
Yes

Direct Drive

25 mm

Stepper Motor

330 nm

8 mm/minute

Top, Bottom

Software — rate, step size

USB

24
7 kHz

14
2 kHz

14
48 kHz

2 kHz - 800 kHz
10 Vpp
TBD

PID
> 3 kHz
Yes
0-150V

0-150V
> 200 Hz
22 Bits

> 20 p sec.
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SPECIFICATIONS coiues

>

WoRKSHOR

Software

»  Environment

» QOperating System
» Image Acquisition

» Control Parameters
PID
Setpoint
Range
Scan Rate
Image Rotate
» Laser Align
» Vibrating Freq. Display
» Force Distance
» Tip Approach
» Oscilloscope
» Image Store Format
» Image Pixels
» H.V. Gain Control
» Real time display

» Calibration
» Probe Center

V1.5

Lab VIEW
Windows 7

Real Time Display
(2 of 8 channels)

Yes

Yes

Yes

Yes

0 and 90 degrees

Yes

Yes

Yes

Yes

Yes

Industry Standard
16 X 16t0 1024 X 1024
XY and Z

Line Level, Light Shaded,
Grey Color Pallet
System Window

Yes

» Video Microscope

Field of view

Resolution

Working Distance

Magnification

» Computer

*

2X2mm 300X 300u
1.5

114 mm 114 mm
400X

Industry Standard
Computer

Z Noise performance depends greatly on the environment the

TT-AFM is used in. Best Z noise performance is obtained in a

vibration free environment.

** Every effort is made to present accurate specifications,
however, due to circumstances out of the AFMWorkshop's
control specifications are subject to change.
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